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Cognitive Optical Brain Imaging (COBI) Studio  

fNIR Devices LLC. Copyright © 2018 

 

This manual and the information contained herein are confidential and proprietary to 

fNIR Devices LLC (“fNIR Devices”). Only fNIR Devices or its Licensees have the right to 

use the information. Any unauthorized use, disclosure or reproduction is a violation of 

the licenses and/or fNIR Devices’ proprietary rights and will be prosecuted to the full 

extent of the law. 

Disclaimer 

Neither fNIR Devices LLC. nor any of its worldwide subsidiaries shall be liable in any 

manner in respect to bodily injury and/or property damage arising from this product 

or the use thereof if the unit is not operated and maintained in strict compliance with 

instructions and safety precautions contained herein, in all supplements hereto and 

according to all terms of warranty and sale relevant to this product. 

Caution 

This device is limited by United States law for investigational and research purposes 

only. 
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Notice to Users: Accident Reporting 

The FDA Medical Device Reporting Regulation, 21 CFR 803 and the CE Council Directive 

93/42/EEC concerning Medical Devices require that 

“the manufacturer of medical devices submit a report to the FDA or local competent 

authorities whenever he becomes aware of information that reasonably suggests that one of 

his installed devices: 

• May have caused or contributed to a death or serious injury, or 

• Has malfunctioned and, if the malfunction recurs, is likely to cause or contribute to a death 

or serious injury.” 

In order for fNIR Devices LLC. to comply with these requirements, all users of this equipment, 

operators and service technicians, are required to provide the Quality Assurance Manager at 

fNIR Devices with the following information regarding all reportable events as soon as 

possible: 

1. Identification of the model and serial number. 

2. Description of the event. Include whether any serious injury or death has occurred. 

Identification of the person who is submitting the information including phone number and fax 

number if available. 
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Please refer to COBI Studio in your publications with the following:   

Ayaz, H. (2005). “Analytical software and stimulus-presentation platform to utilize, 

visualize and analyze near-infrared spectroscopy measures”. MS Thesis, Drexel 

University, Philadelphia, PA.   

 

 

 

Disclaimer 

 

THIS SOFTWARE IS PROVIDED ''AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 

THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 

EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 

EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 

GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 

THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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1. What is in the Box? 
Congratulations, you have just received the fNIR Imager, a non-invasive oxygenation and blood volume 

trend imager. The fNIR Imager is designed to allow you to track relative oxygen consumption as well as 

changes in blood volume. This manual will enable you to become familiar with the fNIR Imager operation, 

the technology of the unit, and the software (COBI Studio), which you will use to collect data from the 

device. 

Based on the product type you purchased, your shipment should include one of the following hardware 

configurations. 

fNIR Model 2000S (included fNIR Systems 100, 200, 300 and 400) 

• S-series standard desktop fNIR control box unit  

• AC power supply unit (attached power cable) 

• Adult Sensor Head and Sensor Pad (attached cable that will be connected to control box) 

• Electric cable between the fNIR control box and the AC power supply unit 

• USB cable between the fNIR control box main unit and a personal computer 

• DVD with software setup files (COBI Studio and USB drivers) 

fNIR Model 1200C (included fNIR Systems 100, 200, 300 and 400) 

• C-series mini fNIR control box unit  

• AC power supply unit (attached power cable) 

• Adult Sensor Head and Sensor Pad (attached cable that will be connected to control box) 

• Electric cable between the fNIR control box and the AC power supply unit 

• USB cable between the fNIR control box main unit and a personal computer 

• DVD with software setup files (COBI Studio and USB drivers) 

fNIR Model 1200S   

• S-series standard desktop fNIR control box unit  

• AC power supply unit (attached power cable) 

• Adult Sensor Head and Sensor Pad (attached cable that will be connected to control box) 

• Electric cable between the fNIR control box and the AC power supply unit 

• USB cable between the fNIR control box main unit and a personal computer 

• DVD with software setup files (COBI Studio and USB drivers) 

fNIR Model 1200W  

• W-series mini wireless fNIR control box unit  

• AC power supply unit (attached power cable) 

• Pediatric Sensor Pad (attached cable that will be connected to fNIR control box) 

• Wireless receiver adaptor (USB based TRX dongle). 

• DVD with software setup files (COBI Studio and wireless receiver drivers) 
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To operate the fNIR System you will need a personal computer (Desktop or Laptop) with USB (version 2 

or higher) port. For more details on computer requirements please see the following section.  

fNIR Systems 200, 300 and 400 ship with a dedicated data acquisition computer that is pre-configured 

and optimized for use with fNIR Imager. 

 

 

S-series control box: fNIR Model 2000S  

 

C-series control box: fNIR Model 2000C  
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S-series control box: fNIR Model 1200S  

 

S-series parts: fNIR sensor head (blue box and cables) + fNIR Sensor pad (black headband) [48 

channels/16 optodes full forehead] 



fNIR Imager & COBI Studio Manual 2018 

 

10 | P a g e  
COBI Manual version 6.5 

   

W-series 1200 wireless and battery operated control box (left) and pediatric sensor pad (right): 

Compatible with both S-series and W-series (all models) [6 channels /2 optodes] 

 

 

Split sensor: Compatible with both Model 1200 S-series and W-series (all models) [12 channels /4 

optodes total in two independent pads] 
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Side by side size comparison of Model 2000 S-series and C-series with Model 1200 W-series boxes 

 

 
Side by side size comparison of Model 1200 S-series and W-series fNIR control boxes 
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Packaging contents for the W-series fNIR Model 1200W (mini wireless unit)  
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2. Background Information 

2.1. Basic Theory of fNIR Imaging 
All biological tissue is, to differing extents, permeable to electromagnetic (EM) radiation of different 

frequencies and intensities. This can also be considered as permeability of biological tissue to photons of 

different energy levels. This principle constitutes the basis of all imaging techniques that rely on 

transmission/scattering characteristics electromagnetic radiation, such as x-ray, Computed Axial 

Tomography (CAT), and photons for Near Infrared imaging. From the principles of spectroscopy, it is also 

known that different molecules absorb different wavelengths of EM radiation (which is synonymously 

referred to as light at smaller wavelengths) to different degrees, and likewise scatter that radiation to 

different degrees. In functional Near Infrared (fNIR) imaging, the molecule of concern is the hemoglobin 

molecule, which is the oxygen carrier for red blood cells. Since oxygenated hemoglobin, also referred to 

as oxy-hemoglobin or HbO2, absorbs light at a slightly different portion of the NIR spectrum than the 

deoxygenated hemoglobin molecules (usually referred to only as hemoglobin or Hb), it is possible to 

detect the relative concentrations of the two molecules using optical spectroscopic methods. 

Photons emanating from any light source follow a characteristic path through the target tissue back to a 

detector that lies on the same approximate plane as the source (see Figure 1 below). While the light is 

severely attenuated due to the scattering and absorption processes, it is nonetheless encoded with the 

spectroscopic signatures of the molecules encountered en route to the detector. By carefully choosing 

the wavelengths that are produced by the source, it is possible to detect the relative concentrations of Hb 

and HbO2 in the target tissue. By comparing these levels to those obtained when the tissue is in its 

“baseline” state, and using some basic knowledge about “interesting” conditions for the tissue, it is 

possible to draw conclusions from systematic changes observed in these levels. 

As a more concrete example, one may consider fNIR imaging of breast tissue. Here, the baseline condition 

of the breast tissue corresponds to its normal, healthy state. The interesting condition is the cancerous 

tissue. Since it is known that such tissue grows uncontrollably, the tissue must metabolize more than the 

baseline tissue. Therefore, to scan for tumors, one looks for concentrated areas of unusually high 

respiration levels. 

 

 

Figure 1. Simulated photon diffusion path through target tissue from source to detector. This simulation shows the photon 
path density, not the overall transmission level. 
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2.2. The Mathematical Basis of fNIR Imaging  
At the heart of the calculations used with fNIR imaging is the Beer–Lambert Law, which defines a linear 

relationship between absorption of EM radiation and the concentration of the target absorptive material 

in a given medium. The full law includes factors accounting for the absorption coefficient (wavelength 

dependent) and path length. Though originally defined for transmittance, it can be shown to be effective 

for diffusion/scattering as well. The measurements are initially taken in terms of received photon 

concentration, which can loosely be termed the “received power.” For biological fNIR imaging use, 

baseline data is first gathered. This reading is considered the “transmitter power.” Given these values, we 

can write the law as: 

 

Since the law itself is linear, the total absorbance of any species is the sum of the absorbances of that 

species for each wavelength. Using these properties of the law, it is possible to take the received photon 

densities to calculate the Hb and HbO2 levels in the target medium in relation to the levels at baseline. 

This is a point that bears reiterating. The levels of Hb and HbO2 measured are relative to the baseline only. 

It is not possible to arrive at absolute values of concentration using fNIR imaging on living samples. Once 

the Hb and HbO2 levels are computed, they are used to calculate the levels of oxygenation (in M), and 

values that may be approximately treated as percent changes in blood volume. The formulae are as 

follows: 

  











powerdtransmitte

powerreceived
Absorbance log
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3. Introduction 
Cognitive Optical Brain Imaging (COBI) Studio is a hardware integrated software platform that enables 

users to acquire process and visualize fNIR signals. Figure 2, below depicts the components of the S-series 

system (standard) and, Figure 3, depicts the system components of W-series system (mini and wireless). 

 
Figure 2 Components of S-series fNIR Model 1200S System 

 
Figure 3 Components of W-series fNIR Model 1200W System 

COBI Studio is an extendable software environment that uses dynamic link libraries to facilitate selected 

key features at run time. A dynamic link library that interacts with the sensory hardware or any other 

source of data is defined as the COBI device or device; which are basically data adapters. By selecting 

different devices at run time, a user can change the data source. Devices that are currently available are 

those that collect data from fNIR Imager hardware, from a TCP/IP port – wireless network, a file in 

computer HDD– network share or a simulator (creates artificial data for simulation). Adding different COBI 

devices will enable COBI to interact and collect data from new kinds of physical devices. 

COBI Studio has a configurable user interface. Users can adjust the view and change visualization options 

to accommodate their needs. COBI Studio provides several customizable tools; including 2D graphs and 

topographic views in order to visualize data. A user can select and place these tools into the current view. 

The placement of these tools, the data integration structure and the view of the COBI program is defined 

as the COBI layout or layout.  A user can create new layouts, save the current layout, or load and edit 

layouts from files. The layout provides a customizable way for users to interact with data.  
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The main screen, as shown in Figure 4, highlights the various options available for the user including a 

main menu, toolbars and side pane for general commands and settings, and a layout area for visualization 

of raw or oxygenation data by graphs. 

 

 

 

 

Figure 4. COBI main window and components 

3.1. Requirements 
System Requirements are as follows:  

1. CPU: 2GHz or better processor, recommended quad-core. 
2. Memory: Minimum system RAM of 1GB, recommended 2GB or more. 
3. Operating Systems: Windows XP, Windows Vista, Windows 7, Windows 8 

For fNIR hardware interface: 
4. USB version 2.0 ports 
5. National Instrument NIDAQmx driver 

 For Network interface: 
6. Wireless or LAN Network adapter 

Message Pane 

Side Pane 

Main Toolbar 

Layout Area 

Main Menu 
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4. Setup 
The setup process includes installation of National Instrument USB Driver and installation of COBI Studio 

to the computer that is going to be used with fNIR Imager. COBI Web Update utility can be used to check 

and download updates for all COBI Studio modules. After installation, one time settings are required for 

COBI Studio to operate the fNIR Imager.  

4.1. Model 2000S and 2000C (USB Driver Installation) 
1. Connect USB cable from fNIR Imager to the computer (while fNIR Imager is powered). The 

computer should identify and finalize driver installation automatically. 

4.2. Model 1200S (USB Driver Installation) 
WARNING: Do not connect the device (USB cable) to the computer before installing the National 

Instrument USB driver (NIDAQmx).  

2. Run 'Setup.exe' in the following folder of the disc: \Driver\USB 

3. Follow onscreen directions. (click next) 

4. Once the installation ends, restart the computer. 

5. Connect USB cable from fNIR Imager to the computer (while fNIR Imager is powered). The 

computer should identify and finalize driver installation 

4.3. Model 12000W (Wireless Receiver Driver Installation) 
1. Driver files are located at the following folder of the disc: \Driver\Wireless 

2. Plug the USB-dongle (receiver) into the computer. When plugged first time, the following notice 

will appear 

 

3. The Windows installation Wizard will start and guide the user through the driver installation 

procedure. Please select “Install from a list or specific location” as shown below. 
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Note: Driver update can also be initiated from Device manager. 

 
 

4. Click ‘Next’ to advance to the next step. Select “Search for the best driver in these locations” as 

shown in Figure 3. Make sure that the wizard searches the driver directory on the disc 

containing the driver file:  usb_cdc_driver_cc2531.inf.  

   

5. Click Next to advance to the next step. Windows will now search for the driver which may take 

some time. 



fNIR Imager & COBI Studio Manual 2018 

 

19 | P a g e  
COBI Manual version 6.5 

    

6. You are now likely to encounter one of the warning dialogs shown below. If that’s the case you 

can safely click ‘Continue anyway’ or ‘Install this driver’ and the installation will be complete. 

      

7. When Windows has finished installing the device, a new serial port will show in the device 

manager in Windows. See below.  

 

 

8. The Virtual COM-port is now ready and can be used as any standard serial port. Right-click on 

the installed CDC Serial Port, select “Properties” and then the “Port Settings” tab.  Configure as 

shown below.  Configure COBI to use the same COM port and settings. 
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4.4. COBI Studio Installation 

1. Run CobiStudioSetup.exe file by double clicking on it. (Your Windows user account 

needs to have administrator rights in order to complete installation). 

 
 

2. Press next to start installation procedure. 

 

 
 

3. Please read the license agreement and accept the conditions of the agreement to 

continue with the installation. 

 



fNIR Imager & COBI Studio Manual 2018 

 

21 | P a g e  
COBI Manual version 6.5 

 
 

4. Press next to accept components. By default all components are selected and this is the 

suggested option. 

 

 
 

5. Press Install to confirm the installation folder and start installation. 

 

 
 

6. Finally, you should receive the following end message. If the “launch the program” is 

checked, COBI Studio Update tool will be executed to check for any updates (See next 

section). 
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4.5. Web Update 

1. Press close to finalize setup. Next, please run ‘Start>COBI>Update from Web’ to get the latest 

versions  

 

 
 

2. Web Update tool will appear as follows. Make sure you are connected to internet and close 

COBI Studio. 

 

 
 

3. If you have updates available, the following screen will appear. Otherwise, Update tool will tell 

you that all files are up-to-date.  
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4. Available updates and the version numbers are listed. You can edit the list and select only the 

updates you want. 

 

 
 

5. Finally, when the updates are downloaded, the following message as shown in the figure below 

is displayed. Some updates may require update application to restart.  
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4.6. Initial Settings for COBI Studio 
After a new installation, the following settings are required for COBI Studio to operate the fNIR Imager. 

These are one-time settings, and will be kept until the user changes them.  

After the installation: 

1. Launch the COBI Studio either by double clicking the shortcut on the desktop or selecting 

‘Start>COBI>COBI Studio’ from Windows Start Menu. 

 

2. On the main window, Click on 'Select Device' from side menu (on the left hand side) 

 

 

 2. Click on ‘Select Device’  
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3. Select ‘fnirUSB.dll’ from the list and click 'Select' button (If fnirUSB.dll is not in the list, the driver 

installation was not completed.) For wireless system, select fnirSerial.dll (and make sure the 

same com port as driver is selected). 

      

 

 

4. On the same window, on the left, go to Layout>Layout Operations 

5. Check 'Load the following layout at start-up'  

    

 

 

6. Click on '...' button and select 'raw.clf' under the COBI Studio Installation Folder. (This folder is 

usually c:\Program Files\COBI Studio) 

7. Click ‘Close’ button and restart COBI Studio  

3a. Click on ‘fnirUSB.dll’ (for S-series) or ‘fnirSerial.dll (for W-series/wireless) 

 

3b. Click ‘Select’ button 

to finalize selection.  

 

4. Select Layout>Layout Operations  

 

5. Check ‘Load the following layout at start-up’ 

 

6. Click ‘…’ button and 

select on the open file 

dialog, select ‘raw.clf’ 

that is in the COBI 

installation folder. 
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5. Operating Procedure 
This section summarizes the main steps for operating fNIR Imager collecting data with COBI Studio. 

5.1. Applying the Adult Sensor  
Applying the sensor pad correctly is the most important step in getting good data.  

Depending on the subject’s hair length, a hair band can be used to hold the subject’s hair. Then, pull the 

subject’s hair back with one hand and gently hold the sensor pad with the palm of your other hand to 

place onto the subject’s forehead. DO NOT STRAIN THE WIRES ON THE SIDES OF THE SENSOR PAD; 

INSTEAD USE STRAPS (two on both sides and cord locks) TO POSITION THE SENSOR; MAKE SURE THAT THE 

CONNECTOR EDGE “1” IS ON THE LEFT SIDE OF THE SUBJECT’S FOREHEAD.    

Keep the sensor pad on the forehead and maneuver the two cables to the back of the subject’s head. Stay 

in this position while you fasten the two cables (from two connectors of sensor pad) all the way around 

the subject’s head, and then use a clip to keep them in place. Use the cord locks with the cloth straps and 

adjust the tightness to make tight fit while comfortable for subject. Make sure that the headband is tight 

and the sensor makes good contact with the forehead, but it must not be too tight or it will constrict blood 

circulation. Finally, place an opaque cover (e.g. headband, cap or tape) over the subject’s head, to keep 

out the extraneous light (i.e. sunlight). If possible, dim the lights or cover windows in the examination 

room during the test.  

5.2. Applying the Pediatric Sensor  
Applying the pediatric sensor similar to the adult sensor, except, it is smaller and localized. Use a flat 

strap to tie around the head for positioning the sensor. Placing an opaque elastic headband or cap over 

the sensor could help preventing ambient light reaching the sensor and also help fixating its position. 

Make sure that the headband is tight and the sensor makes good contact with the forehead, but it must 

not be too tight or it will constrict blood circulation.  

5.3. Binding Procedure (wireless system) 
1. Insert wireless receiver dongle (TRX wireless USB adaptor) into a PC USB port.  Verify the COM 

port assignments in COBI Studio and the Windows Device Manager match. 

2. Power on the control box unit (1200W) transmitter. 

3. Press the “BIND” button on the wireless adaptor ONCE. 

4. Press the “BIND” button on the control box unit transmitter ONCE. 

5. Verify the red “BIND” indicators on both the control box unit transmitter and the USB wireless 

adaptor. 

6. System is ready to operate. 

5.4. Starting COBI Studio 
1. Launch the COBI Studio either by double clicking the shortcut on the desktop or selecting 

‘Start>COBI>COBI Studio’ from Windows Start Menu. 
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2. On the main window, click on 'Start Current Device' from side menu (on the left hand side) 

NOTE: Make sure, fNIR Imager is powered on and is connected to the computer and the sensor 

pad. 

 

 

Once the current COBI device (fnirUSB.dll) is successfully started to operate the fNIR Imager, the 

following messages appear at the message pane of the main window: 

• [fnirUSB.dll] Dev1: NI USB 6221 will be used for data acquisition 

• Started device fnirUSB.dll .... 

 

And, graphs start being updated to show new data. 

 

3. Wait for signal traces to stabilize. If any of the values in the box on the top left are high (> 

4000mV), the sensor pad is not in contact to the subject. The sensor pad needs to be tightened 

slightly. If the values are low (< 400mV), check for hair under the sensor. 

NOTE: Depending on different contours, positions, and skin color of the subject several device 

parameters may need to be changed. To do that, first “Stop Current Device”, and then click “Device 

Settings” at the side pane. 

The following window will appear. In the ‘Data Acquisition Settings’ tab, you can view and change a 

couple of parameters. ‘LED Drive Current’ should have a value in between 5mA to 20mA. Larger values 

will result in brighter light and will increase the signal levels.  

2. Click on ‘Start Current Device’  
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For more information about fnirUSB.dll properties, see page 47. After you type in a value, click on the 

‘Save’ button and go to step 2 (to re-start data acquisition). 

 

  
 

4. As verified in step 3, if signal levels are acceptable, click on ‘Start Baseline’ on side pane. After 10 

seconds, baseline will automatically end. Baseline signal levels will be used to calculate 

oxygenation via Modified Beer Lambert Law. Baseline start and end messages will appear on the 

message pane. 

 

5. After baseline is ended automatically (can be seen at the message pane), click on ‘Start 

Recording’ on side pane. Message pane should display ‘Recording…”. After this point, all data 

will be saved to the specified data file. For more information about data file structure, please 

see page 48. 

 

LED Current should be between 5 to 20 mA.  

 

4. Click on ‘Start Baseline’  

5. Click on ‘Start Recording’  
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WARNING: No data is saved to file unless ‘Recording’ is started. Recording event can be 

scheduled to start right after baseline completion. See View>Scheduling menu item options.  

 

NOTE: Data file to be used (file name, etc.) can be specified at the ‘File Settings’ tab of ‘Device 

Settings’ window before data acquisition is started. ‘Device Settings’ window can be accessed by 

clicking on ‘Device Settings’ on the side pane.  WARNING: The same filename will be used  

Use ‘experiment mode’ to automatically name and organize data files. See page 32 for more 

information about ‘experiment mode’. 

  

6.  After recording is started, subject can perform the experiment protocol.  

7. After the experiment protocol is finished, click ‘Stop Current Device’ to stop data acquisition. 

The following message should be displayed at the message pane: 

 

• Stopped device fnirUSB.dll ! 

WARNING: If you are not using the ‘Experiment Mode’, it is recommended to copy the data file to a new 

folder, since if you re-start data acquisition (using the same file settings), the previous data file will be 

overwritten.  For information about the ‘Experiment mode’, see page 32. 

6. Basic Configurations & Settings 
Basic configurations include configuring the data adapter, layout, device settings and finally beginning the 

data acquisition. Please note the various settings dialogs referred below can also be accessed via the top 

menu or the toolbar, but the easiest access is through the side pane. In addition, any error messages, 

guiding information and reports are displayed in the message pane. 

6.1. Configuring Data Source 
COBI can be configured to acquire data from different sources. A dynamic link library that interacts with 

the sensory hardware or any other source of data is defined as COBI device or device. In Table 1 below, a 

description of each available device is provided.   

Table 1. Summary of the COBI Devices that comes with the installation 

COBI Device Description 

fnir2000.dll For data acquisition from Model 2000  fNIR Imager hardware via USB 

fnirUSB.dll For data acquisition from Model 1200 fNIR Imager hardware via USB port 

fnirUSBnet.dll For data acquisition from fNIR Imager and broadcasting over network 

fnirSerial.dll For data acquisition from wireless fNIR device through wireless dongle  

fnirFile.dll For loading/replaying existing fNIR data file from hard-disk 

SimData.dll For viewing simulated/artificial data to test 

NetworkData.dll For data acquisition through local/internet network from fnirUSBnet.dll 

 

To see or change the current COBI device, click on “select device” on the side pane. The following 

window will appear that displays the available devices list. 
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1. Click on a ‘COBI Device Adapter’ 

to see more information 

 

2. Click ‘Select’ button 

to finalize selection.  
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6.2. Configuring Layout 
COBI Studio allows users to setup customized layouts that include temporal and spatial graphs, their 

numbers, locations, data binding settings and visual settings. Once a custom layout is configured, it can 

be saved as an individual layout file and can be loaded later. Layout Manager is the tool to 

edit/load/save layouts. Layout Manager can be accessed from the LM toolbar button or from the side 

pane. Notice the list on the left-hand side that allows browsing to other settings. 

     

  

 

 

 

 

 

 

 

Click on an item (graph) to see 

its settings on the right-hand 

side. You can add new graphs or 

remove existing ones. The order 

can also be changed using ‘up’ 

and ‘down’ buttons. 
 

Topograph can be added or 

removed and its contents (raw 

channels, oxy or BV can be 

selected at the top of the dialog. 

Data-binding can be set manually 

by typing the channels separated 

by a comma, or automatically using 

the dialogs below (by clicking the V 

buttons).  

 

Colors of individual channel 

lines, background and ranges 

can be set for each graph by 

using the dialog on the left (by 

clicking the ‘other’ button) 

 

To view this dialog click on the 

‘Display Format’ item either on 

the left-most menu or at the side 

pane. 

 

Global ranges (fixed or automatic) 

can be set here. Graphs can be 

updated by sweep or trace 

methods. Sweep is recommended 

for layouts with multiple graphs. 
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Moreover, in the display format dialog, graph height can be set as well. This will be shared by all graphs. 

An individual graph that covers the entire screen can be made as well as multiple graphs that fit in one 

screen. The width of the graphs is calculated automatically from the screen width by using the ‘display 

graphs in column of’ parameter. This specifies how many graphs will be placed next to each other in a 

single row. The Width parameter specifies how many data points each graph will draw at once. 

6.2.1. Save/Load Layout 

All layout settings can be saved into a file at the ‘layout operations’ dialog. This can be either reached 

from the side pane, or by opening the properties dialog first and selecting ‘layout operations’ from the 

list on the left. 

Layout operations dialog allows users to save the current layout to a file, load an existing layout file or 

just clear the layout from all graphs and topographs. Also, a certain layout file can be set to load 

automatically when COBI Studio is launched. Two layout files (raw.clf and oxy.clf) come with the 

installation. 

 

6.3. Configuring Experiments 

 

When ‘start new experiment’ is clicked, a wizard with the following screens appear. These screens collect 

information related to the experiment and save it along with all other experimental data. This helps with 

tracking information. 

COBI Studio is designed for performing serial 

experiments. To save all experimental data (fNIR, 

synchronization markers from external presentation 

stimuli, etc.) in a standardized way, COBI provides the 

experiment tool. A new experiment can be initiated by 

clicking the toolbar button or the side pane link as shown 

in the figure to the right. 

Start New 

Experiment 

Start New 

Experiment 
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1. The first screen requires the user to enter his/her initials. Also, the experiment date that will be 

saved is shown for confirmation. If the date is wrong, check the system date of the windows 

operating system. Click Next to continue. 

 
 

2. The second screen allows the user to enter subject ID, experiment ID and optional subject 

information and description text about the experiment where a user can give specific 

information.  

 
 

3. Finally, the user is presented with a summary of the information entered and asked to confirm 

and click finish. Once finish is clicked, the following message appears at the message pane (of 

the main window). 
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7. Start Acquisition & Recording 

                                            

 

 

 

 

 

 

 

8. User Interface & Functions 
The figure below depicts the buttons and the respective functions of the main toolbar (horizontal) that is 

located at top of the message pane. 

 

 

 

 

 

 

Data acquisition can be started by clicking on the 

‘start current device’ in the toolbar or in the side 

pane. Current device can be set to different 

options. To get data from the fNIR Imager 

hardware, current device should be fnirUSB.dll or 

its variants (fnirUSB*.dll). For more information 

about setting a device, please see hardware 

configuration on page 29.  

When ‘start current device’ is clicked, the 

message pane shows the information streaming 

from the device: whether it has started 

successfully or information about the settings. If 

there are graphs in the layout, data will start 

appearing in them. Each graph will display “Not 

recording” with red background until recording 

starts. To save data, first a baseline should be 

started and then ‘start recording’ should be 

clicked as shown on the figure. When recording 

starts, “Rec.”  text is displayed at bottom of the 

graphs. 

CAUTION!  Data is not saved unless, first “start 

baseline” and then “start recording” are clicked.  

 

Start           

Current Device 

Start           

Current Device 

Start           

Baselin

e 

Start           

Baselin

e 

Start           

Recoding 

Start           

Recoding 

Start New Experiment 

Open Data Folder 

Start Current Device 

Stop Current Device 

Start Baseline 

Start Recording 

Show/Hide 

Message Pane 

Show/Hide 

Left Pane 

Show About / References 

Update Auto Ranges 

Show Layout Editor 
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Below are screenshots of some of the main windows of COBI with various layout configurations. The 

first one is the default main-window with side pane, message pane, layout area with toolbars. In the 

second window, the message pane and the side pane are closed, and topographic visualization is 

enabled. The third one is a single graph that covers the whole layout area. 
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8.1. Keyboard Shortcuts 
Below is a list of keyboard shortcuts that can be used when COBI Studio main window is active. 

Keys Action 
 

Ctrl + N New experiment wizard 

Ctrl + C start Current device 

Ctrl + Q stop/Quit current device 

Ctrl + B start Baseline (and will start recording automatically with default settings) 

Ctrl + R start Record (if baseline is set)               

Ctrl + S view device Settings 

Ctrl + L Layout editor 

Ctrl + O layout Operations 

Ctrl + V View data folder 

Ctrl + D select Device 

Ctrl + G toggle Grid lines in graphs 

Ctrl + M toggle Marker display in graphs 

0 manual marker 10 

1-9 manual marker 1-9 
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9. Advanced Settings & Features 
This section includes several settings that require some basic understanding of COBI and are not essential 

for the basic operation of data acquisition. 

9.1. AutoCobi 
AutoCobi is an automation tool for COBI Studio. It can execute data acquisition (baseline, recording) or 

wait for a pre-defined amount of time. Figure below displays the main window of AutoCOBI. Protocol is 

defined as the list of tasks to be executed.  Once, start button is pressed on AutoCOBI, it will execute 

COBI Studio, start baseline and recording automatically and there’s no need for human operator. 

 

                                                        

The following window displays the editor that can be opened using “Edit” button on the main window. 

 

Start executing the 

protocol 

Current Protocol 

(List of tasks) 

Load protocol file (can also 

drag and drop to the 

protocol area) 

Current Protocol 

(List of tasks) 



fNIR Imager & COBI Studio Manual 2018 

 

38 | P a g e  
COBI Manual version 6.5 

Protocol can be edited by adding COBI and WAIT items. COBI item indicates recording time with last 

settings. This will execute COBI Studio, start baseline and recording and stop after the duration 

indicated. WAIT item is simply for break and enables waiting for a predefined amount of time before 

next measurement.  

Protocols can also be saved to a file to load later. After editing a protocol, hit red ‘x’ button at the top 

right corner to close the editor: The following message will appear to save the protocol. Also, main 

window top menu,  Protocol>save menu item can be used to save a protocol to a file. Protocol files are 

saved with *.caf extension by default to indicate “Cobi Automation File”.   

 

9.2. Folders 
Folders settings define important file locations for operation of COBI Studio. Folder settings can be 

accessed from main window, top menu, “View>Folder Settings” menu item. The page is shown below: 

 

There are two important folders: 

1. Current Data Folder: This is the folder where all output files will be saved by default 

and using experiment mode. Note that, if Experiment mode is not used and the 

adapter output setting includes an absolute folder, file will be saved to that location. 

You can always get back to default by using the default button.  

2. Current Module Folder: This is the folder where COBI Studio looks for adaptor dll 

files. This is for advanced users and developers, and this setting shouldn’t be 

changed for normal operation. 



fNIR Imager & COBI Studio Manual 2018 

 

39 | P a g e  
COBI Manual version 6.5 

9.3. Scheduling 
Scheduling allows triggering baseline and recording operations after a specific event. Scheduling settings 

can be accessed from main window, top menu, “View>Scheduling” menu item. The page with default 

settings is shown below: 

 

 

The first checkbox controls if baseline is auto-started. If it is enabled, the trigger conditions are either 

immediately after starting of the device or after a specific number of samples acquired. 

The second option controls if recording is auto-started. If it is enabled, as soon as baseline is completed, 

recording starts. 

 

9.4. Manual Markers 
Markers, in general, are recorded timestamps for events during a data acquisition session to synchronize 

acquired data. There are two types of markers: auto-markers (or just markers) and manual markers. Auto-

markers are automatically generated by an external system (remote computer such as presentation 

computer) and input to the COBI Studio through serial or parallel port. (See page 44). 

Manual markers are generated manually by clicking a button within COBI Studio. Manual markers can be 

useful in a variety of settings, and help data analysis by indicating specific times of certain events. Manual 

markers in COBI are integer numbers (on the main window, left side pane (1-12) and also through 

keyboard F1 through F12 keys (101 through 112) or number (numpad) buttons 1 through 9 for values 1 
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through 9 and 0 button corresponds to value 10 ) and 300 to 302 for (mouse button keys, left, middle and 

right); hence each can be used to identify unique events.  

The manual marker settings window can be accessed from main window, top menu, “View>Manual 

Marker Settings” menu item. The page is shown below with default settings. The side-pane buttons and 

keyboard buttons are enabled by default for manual marker generation, and mouse buttons can be used 

if the second check-box is enabled. 

 

Pressing the manual marker buttons (either at the left pane of main window or through keyboard/mouse 

buttons on capable systems) as shown below will save the exact time and the manual marker type (1-12 

or 300-302) to the manual marker file and also a message is shown in the message pane. Manual markers 

are saved in a file other than auto-markers files. The default name is ‘manualmarker.mrk’; however, if 

experiment wizard is used, manual marker file name for that session is set according to entered 

information as with other data files.  

 

12 manual marker buttons on the 

side bar (under markers tab) 

Markers are shown on the data graphs with types. 

(Manual markers are visualized in different color than 

regular automated markers that are in yellow color) 

Manual markers are also captured from keyboard 

and mouse button key press (on capable systems) 
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The manual marker file is in tab-separated text file format and each marker is recorded on a single line. 

This is different than the auto-marker file shown in page 52 since manual markers are recorded 

independent of origin. In manual marker file, the first column is the current time information relative to 

second start code in the raw fNIR (*.nir) file header and the second column is the type of manual marker 

(1-12 and 300-302). The third and fourth columns include high frequency counter timer data and the last 

column includes a human-readable date and time format. To find the time from the start of experiment, 

the second start code in the fNIR data file (see page 50) has to be divided by 1000 and subtracted from 

the first column of the manual marker file. 

9.5. Marker Mapping 
Marker Mapping is tool for customizing visualization of automated markers. It can be accessed from the 

side pane on the main window or from the list of the properties dialog box located on the left hand side. 

See the graph below for the marker mapping screen. 

By default, automated markers are yellow vertical lines with titles in red.  See Figure 5 (on page 45) for a 

sample graph with several markers. The Marker Mapping tool allows a user to assign different text and 

background colors to a marker. When a marker with the specified title arrives, the system draws the 

marker according to its customized settings. The marker list can contain any number of items and these 

can be removed by using the button on the left. The settings are saved to the COBI configuration file and 

can be automatically retained. 

 

9.6. Self-Check 
WARNING: This feature requires a solid phantom (i.e., a material that mimics optical properties of brain 

tissue). 

Self-Check can be accessed from side pane on the main window or from the top menu: Analyze>Do Self-

Check.  When enabled, this feature will test signal levels at each channel and generate a report. To 

perform a self-check, do the following steps: 

1) Place the sensor pad on a phantom with uniform optical properties 
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2) Wrap the sensor pad and phantom with a black cloth to prevent ambient light leakage 

3) Connect the sensor pad to fNIR Imager Hardware and to the computer 

4) In COBI, select fnirUSB.dll as the current device. 

5) In COBI, click Self-Check to enable it. 

6) In COBI, start current device 
 

In the message pane, COBI will indicate that the self-check process has started. The device will be 

automatically stopped once enough data is collected or you can stop the device if you think enough data 

is collected. Then, the mean and standard deviation of each channel is calculated along with the signal 

level. The final report is presented in the message pane and given a color code (green=ok, yellow=some 

warnings, red=caution). The report and all messages on the message pane can be saved to a file for further 

reference from the top menu “File>Save Pane Messages”. Below is a sample part from a report. 

 

 

9.7. Filter Design 
FIR (finite impulse response) filters can be designed and then applied to the input data at run-time. COBI 

has a filter module that is capable of designing any order of FIR filters using windowing. In the following 

figure, first COBI filter module (CobiFilter.dll) is selected as the “current filter module”.   
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In the dialog below, an FIR filter can be designed by defining the type, order, window function and cut-off 

frequency. When the user press on the calculate button, the corresponding filter coefficients are 

calculated and saved for later use. For example, the Figure below shows two filters that have been 

designed with the COBI filter module. The first one is a 10th order low-pass filter. The normalized cut-off 

frequency is 0.1 and Blackman Window has been used to calculate the coefficients. The second filter is a 

20th order low-pass, with the normalized cut-off frequency of 0.1 which uses a Hamming window. The 

frequency response of both filters has been presented in the following figure.  

 

                      10th order, low-pass, Blackman windowed       20th order, low-pass, Hamming windowed 
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Noisy and filtered data (using run-time FIR filter) 

10. fnirUSB.dll Properties 
This section discusses the common settings and features of ‘fnirUSB*.dll’ variants that operate the fNIR 

Imager device. A variant of this is fnirUSBnet.dll that has similar features, see next section for more 

information. 

Although each variant has specific additional features, all have common features. To see fnirUSB 

properties, click ‘Device Settings’ in the side pane of the COBI main window. 

10.1. Marker Synchronization 
Markers, in general, are recorded timestamps for events during a data acquisition session to synchronize 

acquired data. There are two types of markers: auto-markers (or just markers) and manual markers. Auto-

markers are automatically generated by an external system (remote computer such as presentation 

computer) and input to the COBI Studio through serial or parallel port. On the other hand, manual 

markers are generated manually by clicking a button within COBI Studio (See Page 39). 

fnirUSB.dll of COBI Studio can receive a synchronization (triggering) signal from an external system. These 

are different than Manual Markers as discussed on page 39. Sending synchronization signals (also called 

markers) allows comparing timing of a stimulus presentation with the fNIR data. fnirUSB.dll can receive 

and send markers through a standard serial port (RS232) or parallel port. For outgoing markers see Table 

2 the end of this section. 

Markers are displayed on the temporal graphs as vertical lines with labels. ‘Marker Mapping’ (by clicking 

on the side bar) can be used to give different colors and assign text labels to markers. See the sample 

graph with markers below. 
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Figure 5. COBI graph with markers 

The figure below displays the marker synchronization settings. First, check ‘listen for markers’ to enable 

signal reception. Then select a source (e.g. serial port or parallel port) to listen for markers. A serial port 

number is a computer dependent parameter that may be different on each computer, and if you have 

multiple serial ports each will have a different number. Available ports of a computer can be located by 

using the ‘device manager’ tool of the Windows operating system. For a proper connection via any port 

with a remote computer, the settings should be the same on both computers. More specifically, both 

computers should have the same parameters for the baud rate, data bit, parity and stop bits properties.  

CAUTION! Markers are only listened when fnirUSB.dll is selected as the current device and started by 

clicking ‘start current device’. When fnirUSB.dll is started, it will inform the user if it is listening for 

markers in the message pane. 

 

 

Automated-markers 

(yellow lines) 

Manual-markers 

(green lines) 
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The following is a list of outgoing markers (and byte values) from fnirUSB.dll during data acquisition, if 

markers are enabled. 

Table 2. Outgoing marker list 

Event Name Byte Value Description 

START 10 Data acquisition is started (user pressed start) 

STOP 50 Data acquisition is stopped (user pressed stop) 

BASELINE BEGIN 20 Baseline is started (user pressed baseline button) 

BASELINE END 30 Baseline is complete 

RECORD 40 Record button is pressed 

 

10.2. Remote Control 

Special Markers values can be used as commands to remotely trigger specific data acquisition events in 

COBI Studio (from another computer / stimulus presentation program) through serial port. To do that, 

enable “Use markers to trigger events” in fnirUSB device properties under synchronization settings tab. 

When this feature is enabled, COBI will screen incoming markers (each byte separately) and execute 

respective commands if the value matches. List of current command values are listed in Table 3 below.  

Table 3. Marker values for remote control 

Event Name Byte Value Description 

COBI_RECV_EVENT_BASELINE_BEGIN           251 Baseline is started and ends in 10 seconds. 
(Simulates Baseline button press) 

COBI_RECV_EVENT_RECORDING                253 Start recording data to file  
(Simulates Record button press) 

COBI_RECV_EVENT_STOP                     254 Data acquisition stops, experiment ends 
(Simulates Stop button press) 

CAUTION: For remote control, device needs to be manually started (by clicking start device button) and a 

valid serial port should be enabled for marker synchronization. When the device is started, remote control 

markers can trigger recording of baseline and data and stop the device. However, commands should be 

received in the correct order, i.e. cannot record if baseline is not yet set. And record command should be 

sent at least 10 seconds after the baseline command.  

 

10.3. External Trigger 

fNIR device can produce digital TTL output signal through the BNC type output port (at the back of the 

device) to synchronize any external device with data acquisition events. Please see below for the photo 

of the trigger out port at the back of the device. 
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Trigger out port is a digital port and has two states: low (0 volts) and high (5 volts). The port is low all the 

time except when a special data acquisition events happens; when a pulse is generated on this port, first 

by switching the port status to high for 150ms (pulse length) and then switch back to low again.  

A pulse is generated for all the following events device start, device stop, baseline begin, baseline end and 

record events (also listed in Table 2). 

 

10.4. Data Acquisition Settings 
This section displays advanced settings for the fNIR Imager. Timings such as sampling rate and frame rate 

are read-only.  Two important parameters that can be modified are the LED drive current and the initial 

gain. Advised range for the LED current is between 5mA to 20mA depending on experiment conditions. 

And the initial gain should be 1, 5, 10, 15 or 20. 

 

CAUTION: Please do not change sampling rate setting default value unless you know exactly what you are 

doing. Using high sampling rate with ambient channel and all optodes enabled may disrupt data collection.  
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Within the ‘Data Acquisition Settings’ tab,  ‘Sampling Settings’ group, contains checkboxes to enable or 

disable data acquisition from certain channels. If ‘Get ambient light (dark current)’ is not checked, only 

730nm and 850nm wavelengths will be collected for each optode, eliminating the ambient light. Data file 

structure will be the same but ‘-1’ will be recorded for the ambient raw cell for all 16 optodes. 

The second row of checkboxes enables of disables data acquisition from 4 quadrants separately. Quadrant 

1 contains optodes 1 through 4; quadrant 2 contains optodes 5 through 8; quadrant 3 contains optodes 9 

through 12; and quadrant 4 contains optodes 13 through 16. By default all of them are checked so all 

optodes are sampled. However, if the data acquisition computer does not have enough bandwidth, one 

or more of the quadrants can be disabled to maintain target sampling rate.  

 

10.5. File Settings 
This property allows the user to define the name and location of data files; e.g. fNIR files and marker 

files.  

WARNING: These settings are overridden if an experiment is configured. See the experiment 

configuration section at page 32 for more information.   

 

 

10.6. Data File Format 
The file names and extensions depend on if the experiment is initiated at COBI. If so, fnirUSB.dll acquires 

fNIR data from the fNIR Imager and saves it to a “*.nir” file. Calculated oxy-Hb and deoxy-Hb (using 

selected baselines in Modified Beer Lambert Law) is saved to a “*.oxy” file. Marker data (if listening of 

markers is enabled) is saved to “*.mrk” file. All files are tab-delimited text files and can be opened directly 
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by text editors or Microsoft Excel. If an experiment is not initiated at COBI, then the default file names will 

be “dat_out.nir”, “dat_out.oxy” and “marker.mrk”.  

The figure on page 50, presents the fNIR data file and its components. The first two lines are the header 

followed by the date of the measurement. Next, the initial counter value of the high-resolution-timer is 

recorded, which is followed by its frequency. The frequency is used to convert the timer ticks to 

milliseconds.  

When the user starts the baselines, the line with “-2 Baseline started” is recorded along with 20 frames of 

data with each frame on a single row. After the baseline is complete (marked with -4), data is recorded 

only after the user clicked on “start recording”.  

The first column in the data file is the time value in seconds from start of the current device. Then the rest 

of the columns contain the light intensity data for 16 optodes in 3 wavelengths. The second column (next 

to time column) is the data of optode 1 – wavelength 730nm. The third column is optode 1 – raw ambient 

data (the value would be negative unless ambient data collection is enabled in device settings). And the 

forth column is optode 1 – wavelength 850nm. The next three columns are for optode 2 with again 730nm, 

ambient light intensity and 850nm data, respectively. The grouping of 3 wavelengths continues for all 16 

optodes. So, there are 49 columns in total (1 time column + 3x16=48 light intensity columns). In the 

current fNIR Imager, middle column (between 750nm and 850nm) for each optode is the ambient light 

condition in which no LED is lit during its measurement. This will record ‘-1’ if ambient light acquisition is 

not enabled at the device settings (data acquisition tab>sampling settings). 

The figure on page 51, presents the fNIR oxy data file and its components. The first two lines are the 

header followed by the date of the measurement. Next, the initial counter value of the high-resolution-

timer is recorded and the frequency of it follows. The frequency is used to convert the timer ticks to 

milliseconds.  These are the same as in the fNIR data file. 

The first column in the data file is the time value in seconds since the current device has started. Then the 

rest of the columns contain deoxygenated hemoglobin (Hb) and oxygenated hemoglobin (HbO2) pairs for 

all 16 optodes. So, there are 33 columns in total (1 time column + 2x16 Hb/HbO2 values).  
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10.6.1. fNIR Data File 

Model 2000 units utilize fnir2000.dll and record up to 18 optodes (54 raw light channels) in same format 

as Model 1200 and earlier systems. Optodes 1 through 16 are brain areas same as before. Optode 17 

and Optode 18 are new superficial references optodes from left and right hemispheres respectively. 

 

 

 

  

Header and date 

High resolution timer initial counter and frequency, 

LED current and initial gain parameters 

First column is the time in seconds from start… 

Optode 1 Optode 2 Optode 3 … 

After record button is pressed, (Baseline is set) All data follows… 

Optode 1, Raw 850nm 

Optode 1, Raw Ambient 

Optode 1, Raw 730nm 
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10.6.2. fNIR Oxy File 

Model 2000 units utilize fnir2000.dll and record up to 18 optodes (54 raw light channels) in same format 

as Model 1200 and earlier systems. Optodes 1 through 16 are brain areas same as before. Optode 17 

and Optode 18 are new superficial references optodes from left and right hemispheres respectively. 

 

 

Header and date 

High resolution timer initial counter and frequency, 

LED current and initial gain parameters 

First column is the time in seconds from start… 

Optode 1 Optode 2 Optode 3 … 

Optode 1, Oxy-Hb 

Optode 1, Deoxy-Hb 

Header and date 
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10.6.3. fNIR Marker File 

 

 

  

Header and date 

Start codes are the same as recorded in the data file 

Frame number in fNIR data that this 

marker corresponds to. 

Type of marker (1-255) 

Time (seconds) of marker from start of experiment start 
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11. fnirUSBnet.dll Properties 
This is a variation of fnirUSB.dll with the same basic functionality, but additionally fnirUSBnet.dll can 

broadcast the raw fNIR data over network. In the device settings dialog, there’s an extra tab called 

‘Network Settings’ as shown below. At this window, the device can be set to run online and offline. If the 

device is set to run offline, it is the same as fnirUSB.dll. 

 

When the device is started to run in the online mode, the message pane displays the IP and port 

numbers through which the clients can connect to the device. This information is required on the 

receiving side at the remote system. The default port number is 6343. 

 

12. NetworkData.dll Properties 
This COBI device receives data from network that are broadcasted by fnirUSBnet.dll as described above. 

The device settings dialog allows entering IP and port numbers of a remote COBI system. The received 

data can be logged (if baseline is set and record button is pressed) and the log file name can be changed 

from the settings dialog as shown below. 
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13. SimData.dll Properties 
This is test device that created artificial data in form of varying types of sinusoidal and random signals. 

The frame rate in milliseconds can be set at the settings dialog. Also, SimData.dll can be set to simulate 

receiving markers if ‘Send marker’ is set. 

  

14. fnirSerial.dll Properties 
This section discusses the common settings and features of ‘fnirSerial.dll’ that operate the wireless fNIR 

Imager device. Other properties such as file format, marker synchronization settings, etc are same as 

fnirUSB.dll as both share common features. To see fnirSerial properties, click ‘Device Settings’ in the side 

pane of the COBI main window while fnirSerial.dll is selected as current device. 
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The “Connection” settings indicates the virtual com port established after installation of the wireless 

received driver (as explained in section 4.3). This port is not for markers or time synchronization. Use 

“Synchronization settings” tab for configuring marker recording.  

15. fnir2000.dll Properties 
This section discusses the common settings and features of ‘fnir2000.dll’ that operate the latest fNIR 

Devices Model 2000. Other properties such as file format, marker synchronization settings, etc are same 

as fnirUSB.dll as both share common features. Model 2000 units record up to 18 optodes (54 raw light 

channels) in each nir file in the same format as earlier models. Optodes 1 through 16 are brain areas, 

same as before. Optode 17 and Optode 18 are new superficial reference optodes, left and right 

hemispheres, respectively. 

To see fnir2000 properties, click ‘Device Settings’ in the side pane of the COBI main window while 

fnir2000.dll is selected as current device. Marker synchronization settings are same as fnirUSB.dll that 

captures markers from a serial port or parallel port. 

The “Connection” tab contains the com port number that the Model 2000 fnir device is connected to. 

This can be found at ‘Device Manager’ under ‘Ports (COM&LPT)’ section (see below). This port is not for 

markers or time synchronization. Use “Synchronization settings” tab for configuring marker recording.  
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The ‘Data Acquisition’ tab contains settings for managing light brightness and detector sensitivity. There 

are two entries for each. Main optodes refer to optodes 1 through 16 and reference optodes are short 

distance for superficial skin measurements and they are optodes 17 and 18. The default values are listed 

below.  

 

16. fnirFile.dll Properties 
This COBI device allows reading previously recorded fNIR data files to COBI. In the settings dialog, input 

file name can be set and also the log file name can be changed as shown below. 
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17. COBI Data Folder and Files 
All recorded data files are saved in the COBI Folder, which can be opened by the ‘Open Folder’ button on 

the main toolbar. (See page 34). COBI Data folder is located by default at “My Documents>COBI Studio 

Data” of the current windows user. COBI saves files in tab separated text format so they can be opened 

by any text editor such as Notepad and also Microsoft Excel. fNIR Data file format is explained on page 50 

and fNIR marker file format is explained on page 52. The default file name for a data file is ‘dat_out.nir 

and for a marker file is ‘markers.mrk’ respectively. These names can be changed from the ‘File Settings’ 

tab of ‘Device Settings’ dialog of each device.  

CAUTION!  When experiment mode is enabled (See page 32), all file names settings are automatically 

assigned. 

 

 
 

Below is a list of data files for 2 sessions in the COBI data folder. The first session was recorded with 

experiment mode on and files are named automatically. The ‘HA_0_0_03301510.nir’ is the fNIR data file. 

The marker file has the same name but an extension of ‘mrk’ and the log file also has the same name but 

an extension of ‘log’. When experiment mode is not set, as in the second session, the three data files 

formed are ‘dat_out.nir’ (that is fNIR data file), ‘dat_out.log’ and ‘marker.mrk’ (that is fNIR marker file).  



fNIR Imager & COBI Studio Manual 2018 

 

58 | P a g e  
COBI Manual version 6.5 
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18. Troubleshooting 
 

Description Action 

fnirUSB.dll and its 
variants are not in the 
available device list of 
COBI 

The National Instruments USB driver is not installed or needs to be re-
installed. Go to ‘Add/Remove Programs’ in the control panel of the 
Windows operating system and check to see if National Instrument is 
listed. If so, uninstall it, restart the computer and re-install the driver. 
 

COBI adapter 
‘fnirUSB.dll’ fails to 
start… 
 

Make sure that the fNIR box is powered and connected to the computer. 
Wait a few seconds after device is connected to computer.  If the problem 
persists, try using different USB ports of the computer.  

Raw signal values are 
too high (>4000mV) 

The sensor pad is not in good contact with the subject’s forehead. Tighten 
the probe. 
 

Raw signal values are 
too low (<400mV) 

1) The sensor pad is on something other than skin. Move the probe 
off of hairs, eyebrows, etc. 

2) There’s no power to the fNIR Imager. Check the connection the 
electrical outlet. Check the power box to see the power is on. 

 

Receive a warning 
message while using 
fnirUSB.dll: “Cannot 
maintain sampling 
frequency”. 

This warning indicates that the USB bandwidth and/or computational 
power of the computer may not be adequate. Even with the warning 
message, data acquisition can continue and data can be recorded with the 
best possible sampling even though it is slower than targeted sampling 
rate or default value of 2Hz. Using high sampling rate (>2Hz) with ambient 
channel and all optodes enabled is not recommended. 
 
If there are any unnecessary applications running, closing them before 
starting data acquisition may help. Also, if there are any extra devices 
connected through USB ports, removing them before data acquisition may 
help to improve performance.    
 
Also, try changing sampling settings within fnirUSB.dll device settings 
under ‘data acquisition settings’ tab. One option is to unselect ‘get 
ambient light’ option. This will disable collecting raw ambient light for each 
optode so only 730nm and 850nm data will be collected for each optode. 
 
Another option to improve sampling frequency (controlled from sampling 
settings) is removing quadrants (groups of optodes) from data acquisition 
scheme.  By unselecting one or more quadrants, required USB operations 
at each period will decrease so sampling frequency will improve (especially 
for slower computers).  
 

Receive error messages 
on the message pane 
and data acquisition is 
not continuing 

Close the application and restart. 
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Receive error message 
“cannot open 
specified layout file” 

 
This message indicates that the layout file selected to be loaded at start-up 
is not found or cannot be accessed. Start-up layout file setting can be 
accessed from left-hand side menu, “Layout Operations” and under “Start-
up settings”. 
 

During data 
acquisition, after 
baseline is started, 
receive message 
“baseline XX lambda 
730/850 changed to 1” 
 

This message indicates that channel specified by XX contains 
noisy/problematic data that is not usable in baseline, and thus replaced by 
1 just for oxygenation data view. Please check your sensor, cables and/or 
connections and verify sensor is positioned properly on the subject. 

When starting 
‘fnirSerial.dll’ for 
wireless system, 
message pane 
displays “waiting for 
sensor” message 

Check if the usb receiver is inserted and correct com port is set in the 
device settings>connection tab. 
 
Next, check if usb receiver and the wireless system are binded. On the 
wireless system, “bind” red led should be on. Here are the steps to 
establish binding. 
 
1.      Power off the controller and disconnect the USB stick from the 
computer. 
2.      Reconnect the USB stick to the computer. 
3.      Power on the controller and wait a few seconds. 
4.      Press the bind button on the USB stick. 
5.      Press the bind button on the controller.  
 

  

 

  



fNIR Imager & COBI Studio Manual 2018 

 

61 | P a g e  
COBI Manual version 6.5 

19. Appendix: Specifications 
 

1. Physical Specifications 

1.1. Dimensions of Probe: 18x6x0.8cm 

1.2. Probe Materials: Foam & Wire 

1.3. Number of detectors: 10  

1.4. Number of light sources: 4 

1.5. Light-Source Separation: 2.5 cm 

 

2. Sample Rate Specs 

2.1. Sample rate = 25,000 samples/second or A/D Conversion every 40 microseconds 

2.2.  250 samples per LED wavelength per detector = 10 milliseconds 

2.3.  2 wavelengths per detector = 20 milliseconds 

2.4. For 16 channels = 320 milliseconds for one whole sample 

2.5.  Period  is set to 500ms (full image rate = 2 Hz) 

 

3. LED Specs (Epitex L6X730/6X850) 

3.1. 2 wavelengths: 730, 850nm (+-15nm) 

3.2. Max continuous current/relative power at each wavelength 

3.3. 730: 75ma/90% 

3.4. 850: 100ma/100% 

 

 

4. Opto101 Photodiode Specs: 

4.1. Active area: 2.3x2.3mm 

4.2. Unit to unit detection variation +-5% 

4.3. Non-linearity: .01% of full signal 

4.4. Bandwidth 14kHz 

4.5. Voltage output Vs. Temperature: 100ppm/C 

4.6. Dark Current: 7.5mv 
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